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การใช้โปรแกรมสถติิ
วิเคราะห์ข้อมูลเบื �องต้น



การวิเคราะห์ข้อมูลทางสถติิ

การวิเคราะห์ข้อมลูทางสถิติ เป็นการประมวลผลข้อมลูที�มีปริมาณมาก ดงันั �น
การนําคอมพิวเตอร์มาชว่ยในการวิเคราะห์ข้อมลู จะช่วยประหยดัเวลาและค่าใช้จ่าย 
มีความสะดวกมากกว่าที�จะคํานวณด้วยเครื� องคิดเลขทั�ว ๆ ไป และในการใช้
คอมพิวเตอร์ส่วนใหญ่นิยมที�จะใช้โปรแกรมสําเร็จรูป มากกว่าที�จะเขียนโปรแกรม
ขึ �นมาเอง 

ปัจจบุนัมีโปรแกรมสําเร็จรูปที�ทํางานด้านอื�น ๆ สามารถนํามาวิเคราะห์ข้อมูล
ทางสถิติได้ เช่น โปรแกรม Excel ซึ�งเป็นโปรแกรมประเภทกระดาษทด (Spread
Sheet) แต่เนื�องจากโปรแกรมประเภทนี �ถกูสร้างขึ �นมาสําหรับงานบางอย่างที�ไม่ใช่
สถิติโดยตรง ดังนั �นการวิเคราะห์ข้อมูลด้วยวิธีการทางสถิติบางอย่าง โปรแกรม
ประเภทนี �อาจทําไม่ได้ หรือทําได้แต่อาจจะให้รายละเอียดน้อยกว่า ดงันั �นผู้วิจยัส่วน
ใหญ่จึงนิยมใช้โปรแกรมสําเร็จรูปทางสถิติมากกว่า แต่อย่างไรก็ตาม โปรแกรม 
Excel จะมีความสามารถในด้านการนําเสนอข้อมลูด้วยกราฟหรือแผนภมูิ



ประเภทของสถติิ

สถิติแบ่งออกเป็น 2 ประเภท คือ

1. สถิติพรรณนา (Descriptive Statistics)  เป็นสถิติที�ใช้อธิบายคณุลกัษณะของสิ�งที�
ต้องการศึกษากลุ่มใดกลุ่มหนึ�ง ไม่สามารถอ้างอิงไปยังกลุ่มอื�น ๆ ได้ สถิติที�อยู่ในประเภทนี � เช่น ค่าเฉลี�ย 
ค่ามธัยฐาน ค่าฐานนิยม ส่วนเบี�ยงเบนมาตรฐาน ค่าพิสยั ฯลฯ

2. สถิติอ้างอิง (Inferential Statistics) เป็นสถิติที�ใช้อธิบายคณุลักษณะของสิ�งที�
ต้องการศึกษากลุ่มใดกลุ่มหนึ�ง หรือหลายกลุ่ม แล้วสามารถอ้างอิงไปยังกลุ่มประชากรได้ โดยกลุ่มที�นํามา
ศกึษาจะต้องเป็นตวัแทนที�ดีของประชากร ตวัแทนที�ดีของประชากรได้มาโดยวิธีการสุ่มตวัอย่าง และตวัแทนที�
ดีของประชากรเรียกว่ากลุ่มตวัอย่าง 

สถิติอ้างอิงสามารถแบ่งออกได้เป็น 2 ประเภท คือ



 2.1 สถิติแบบใช้พารามิเตอร์ (Parametric Statistics) เป็นวิธีการทางสถิติที�
จะต้องเป็นไปตามข้อตกลงเบื �องต้น 3 ประการ ดงันี �

- ข้อมลูที�เก็บรวบรวมได้ต้องเป็นข้อมลูที�อยู่ในระดบัช่วง (Interval Scale)
- ข้อมลูที�เก็บรวบรวมได้จากกลุ่มตวัอย่างจะต้องมีการแจกแจงแบบปกติ 

(Interval Scale)
- กลุ่มประชากรแต่ละกลุม่ที�นํามาศกึษาจะต้องมีความแปรปรวนเท่ากนั

                     สถิติมีพารามิเตอร์ เช่น t-test, ANOVA, Regression Analysis 
   เป็นต้น

     2.2 สถิติแบบไม่ใช้พารามิเตอร์ คือ สถิติที�ไม่อยู่ในข้อตกลงเบื �องต้นทั �ง 3 ประการ สถิติ
ประเภทนี � ได้แก่ Chi-Square  การวิเคราะห์ความสมัพนัธ์ 



ระดับของการวัด

การวดัเป็นการกําหนดตวัเลขให้กบัสิ�งที�ต้องการศกึษา แบ่งออกเป็น 4 ระดบั คือ

1. ระดบันามบญัญัติ (Nominal Scale) เป็นระดบัที�ใช้จําแนกความแตกต่างของสิ�งที�
ต้องการวดัออกเป็นกลุ่ม เช่น เพศ การศกึษา อาชีพ ภมูิลําเนา โดยในแต่ละกลุ่มจะแทนด้วยตวัเลข 
เช่น เพศชาย แทนด้วยเลข 1  เพศหญิง แทนด้วยเลข 2

2. ระดบัอนัดบัที�หรือเรียงลําดบั (Ordinal Scales) เป็นระดบัที�ใช้สําหรับจดัอนัดบัที�
หรือตําแหน่งของสิ�งที�ต้องการวดั เช่น ระดบัความพงึพอใจ

พึงพอใจมากที�สดุ = 5 พงึพอใจมาก = 4

พึงพอใจปานกลาง  = 3 พงึพอใจน้อย = 2

พึงพอใจน้อยที�สดุ = 1



3. ระดับช่วง (Interval Scale) เป็นระดบัที�สามารถกําหนดค่าตวัเลขโดยมีช่วงห่างระหว่าง
ตวัเลขเท่า ๆ กนั แต่ไม่มี 0 (ศนูย์) แท้ มีแต่ 0 (ศนูย์) สมมติ เช่น สอบได้ 0 คะแนน มิได้หมายความว่าเขาไม่
มีความรู้ เพียงแต่เขาไม่สามารถทําข้อสอบซึ�งเป็นตวัแทนของความรู้ทั �งหมดได้ หรือ อุณหภูมิ 0 องศา มิได้
หมายความว่าจะไม่มีความร้อน เพียงแต่มีความร้อนเป็น 0 องศาเท่านั �น จุดที�ไม่มีความร้อนอยู่เลยก็คือที� -
273 องศา ดังนั �นอุณหภูมิ 40 องศาจึงไม่สามารถบอกได้ว่ามีความร้อนเป็น 2 เท่าของอุณหภูมิ 20 องศา 
เป็นต้น ตวัเลขในระดบันี �สามารถนํามาบวก ลบ คณู หรือหารกนัได้

4. ระดบัอตัราส่วน (Ratio Scale) เป็นระดบัที�สามารถกําหนดค่าตวัเลขให้กับสิ�งที�ต้องการวดั 
มี 0 (ศูนย์) แท้ เช่น นํ �าหนัก ความสูง อายุ เป็นต้น ระดับนี �สามารถนําตัวเลขมาบวก ลบ คูณ หาร หรือหา
อตัราสว่นกนัได้ คือสามารถบอกได้ว่า ถนนสายหนึ�งยาว 50 กิโลเมตร ยาวเป็น 2 เท่าของถนนอีกสายหนึ�งที�
ยาวเพียง 25 กิโลเมตร 

สรุปได้ว่า

1. Nominal scale
ข้อมลูเชิงคณุภาพ

2. Ordinal scale

3. Interval scale
ข้อมลูเชิงปริมาณ

4. Ratio scale



ประชากรและกลุ่มตัวอย่าง

ในงานวิจยัโดยมาก ค่าของการวดัจะได้มาจากกลุม่ตวัอย่าง ซึ�งมาจากประชากรที�มี
ขนาดใหญ่

ประชากร คือ กลุม่ของการวดัทั �งหมดที�สนใจศกึษา

ตัวอย่าง คือ สบัเซตของการวดัที�มาจากประชากรที�สนใจศกึษา

หลักการสุ่มกลุ่มตัวอย่าง

• สมาชิกเป็นตวัแทนที�ดีของประชากร

• มีคณุลกัษณะสําคญัเหมือนประชากร  

• สมาชิกทกุหน่วยมีโอกาสได้เป็นกลุ่มตวัอย่างเท่ากนั  

• กลุม่ตวัอย่างต้องมีขนาดใหญ่เพียงพอ



ขั�นตอนพื�นฐานในการใช้ SPSSขั�นตอนพื�นฐานในการใช้ SPSS

1.  สร้างแฟ้มข้อมลูที�จะนํามาวิเคราะห์ หรือเปิดจากแฟ้มข้อมลูที�ได้สร้างไว้แล้ว 
รวมทั �งการจดัการข้อมลูให้พร้อมทําการวิเคราะห์

2.  เลือกสถิติวิเคราะห์ที�มีความเหมาะสม สามารถตอบปัญหาการวิจยัได้

3.  เลือกตวัแปรที�ต้องการนํามาวิเคราะห์ข้อมลูตามวตัถปุระสงค์ของการวิจยั



ลักษณะแบบสอบถาม

 แบบสอบถามที�ใช้ในการวิจยัเชิงปริมาณนั �น มกัจะมีรูปแบบดงันี �

ตอนที� 1 สอบถามเกี�ยวกบัสถานภาพทั�วไปของผู้ตอบแบบสอบถาม มกัเป็น 
                        คําถามแบบตรวจสอบรายการ (Check-List) 

ตอนที� 2 สอบถามเกี�ยวกบัลกัษณะโดยทั�วไปของเรื�องที�กําลงัทําวจิยั มกัเป็น
                        คําถามแบบตรวจสอบรายการ (Check-List)

      ตอนที� 3 สอบถามเกี�ยวกบัความพงึพอใจ หรือทศันคติในประเด็นตา่งๆ ของ
                        เรื�องที�ทําวิจยั  ลกัษณะคําถามเป็นแบบมาตราสว่นประมาณคา่ 

(Rating Scale)
      ตอนที� 4 สอบถามข้อเสนอแนะเพื�อการปรับปรุงและพฒันาในเรื�องที�กําลงัทํา

                        วิจยั ลกัษณะคําถามเป็นคําถามปลายเปิด (Open End)



การเตรียมเครื�องมือก่อนการประมวลผล
และวิเคราะห์ข้อมูล

ความพงึพอใจของผู้ใช้บริการที�มีต่อระบบสารสนเทศมหาวิทยาลัยแม่โจ้

ตอนที� 1 ข้อมูลทั�วไปของผู้ตอบแบบสอบถาม

คําชี �แจง โปรดทาํเครื�องหมาย ลงใน (  ) หรือเติมข้อความลงในช่องว่างตรงตามความเป็นจริง

     1. เพศ         (  ) ชาย (  ) หญิง

     2. อาย ุ.................. ปี

      3. ระดบัการศกึษา     (  ) ตํ�ากว่าปริญญาตรี (  ) ปริญญาตรี

     (  ) ปริญญาโท (  ) ปริญญาเอก

      4.  ประเภทบุคลากร  (  ) ข้าราชการ (  ) พนกังานมหาวิทยาลยั

   (  ) พนกังานราชการ (   ) อื�น ๆ..............................................

      5. คณะหรือสํานกัที�สงักดั..............................................................................................................

     

ตัวอย่างแบบสอบถาม



ตอนที� 2  การเข้าใช้งานระบบสารสนเทศ 

คาํชี �แจง โปรดทาํเครื�องหมาย ลงใน (  ) หรือใส่ตัวเลขให้ตรงกับความเป็นจริงลงใน (  )

 1. ความถี�ของการใช้งานระบบสารสนเทศของมหาวิทยาลยั

         (  )  สปัดาห์ละ 1 ครั �ง         (  ) สปัดาห์ละ 2-3 ครั �ง   

   (  ) สปัดาห์ละ 4-5 ครั �ง      (  ) ใช้ทกุวนั

     2. ช่วงเวลาที�ท่านเข้าใช้บริการระบบสารสนเทศ (ตอบได้มากกว่า 1 ข้อ)

           (  ) เวลา 08.00-10.00 น.    (  ) เวลา 10.00-12.00 น.     

    (  ) เวลา 12.00-15.00 น.    (  ) เวลา 15.00-17.00 น.

           (  ) เวลา 17.00-20.00 น.     (  ) เวลา 20.00-00.00 น.    

           (  ) เวลา 00.00-08.00 น.   

      3. ระบบสารสนเทศของมหาวิทยาลยัที�ทา่นใช้บ่อยที�สดุ  3 อนัดบัแรก

     (  ) ระบบเอกสารราชการ (  ) ระบบการลาออนไลน์

     (  ) ระบบการบริหารงานพสัดุ (  ) ระบบโครงการ (e-project)

(  ) ระบบการบริหารงานประชมุ 



ตอนที� 3  ความพงึพอใจต่อการใช้บริการระบบสารสนเทศ

คําชี �แจง โปรดทาํเครื�องหมาย  ลงในช่องที�ตรงกับความรู้สึกมากที�สุด

ข้อความ ความพงึพอใจ

มากที�สดุ มาก ปานกลาง น้อย น้อยที�สดุ

1.  ด้านการให้บริการของเจ้าหน้าที�

     1.1 ให้บริการด้วยความสภุาพและเป็นมิตร

     1.2 ดแูล เอาใจใส่ เต็มใจให้บริการ

     1.3 ให้คําแนะนํา หรือตอบข้อซกัถามตรงประเด็น

     1.4  มีเจ้าหน้าที�ประจําหน่วยงานตลอดช่วยการ
           ให้บริการ

2. ด้านกระบวนการขั �นตอนการให้บริการ

     2.1 ให้บริการอย่างเป็นระบบ และเป็นขั �นตอน

     2.2 ความรวดเร็วในการให้บริการ

     2.3 ข้อมลูที�ให้มีความชดัเจน ถกูต้อง และเข้าใจง่าย



ตอนที� 4  ข้อเสนอแนะ               
         .................................................................................................................................

         .................................................................................................................................

               .................................................................................................................................

               .................................................................................................................................



           ตัวแปร
ตวัแปร คือ ชื�อที�ใช้เรียกแทนข้อคําถามในเครื�องมือที�เก็บข้อมลู มกัจะตั �งชื�อตวัแปรเป็น

ภาษาองักฤษ และมีความยาวไม่เกิน8 ตวัอกัขระ เพื�อให้โปรแกรม SPSS สามารถเข้าใจได้

ชนิดของตัวแปร
ชนิดของตวัแปร แบง่ออกเป็น 2 ชนิด คือ

1. ตวัแปรเชิงปริมาณ คือ ตวัแปรที�มีคา่เป็นตวัเลข ที�ระบไุด้วา่มีคา่มากหรือน้อย  เช่น  รายได้
อาย ุ  นํ �าหนกั  ส่วนสงู  ขนาดของตวัแปร รายได้มี  6 หลกั อายมุี 2 หลกั นํ �าหนกัมี  3 หลกั ส่วนสงูมี 3 หลกั

เป็นต้น

2. ตวัแปรเชิงคณุภาพหรือตวัแปรเชิงกลุม่ คือ ตวัแปรที�เป็นข้อความ หรือตวัแปรที�ต้องใช้ตวัเลข
แทนคา่รหสัของข้อมลู  ซึ�งขนาดของตวัแปร ควรจะเท่ากบัจํานวนทางเลือกของคําตอบ เช่น เพศ จําแนกเป็น 
2 กลุม่ คือ เพศชาย และเพศหญิง  ระดบัความคิดเหน็มี 5 ระดบั ขนาดของตวัแปรกําหนด เป็น 1 หลกั แตถ้่า
ระดบัความคิดเหน็ม1ี0 ระดบั ขนาดของตวัแปรควรกําหนดเป็น 2 หลกั เป็นต้น

การสร้างรหัสสาํหรับข้อมูล



การกาํหนดรหัสโดยแบ่งตามชนิดของคําถาม

การกําหนดรหสัของข้อมลูจะต้องคํานงึถึงชนิดของคําถาม โดยชนิดของคําถามแบ่งออกเป็น

1. คําถามปลายปิด แบ่งออกเป็น

•  คําถามที�มคีําตอบให้เลือกเพียง 2 คําตอบ เช่น เพศ มี  1) เพศชาย และ 2) เพศหญิง

•  คําถามที�มคีําตอบให้เลือกหลายคําตอบ เช่น ประเภทบุคลากร มี 1) ข้าราชการ  

2) พนกังานมหาวิทยาลยั 3) พนกังานราชการ 4) อื�น ๆ

•  คําถามที�สามารถเลือกคําตอบได้หลายคําตอบ หรือตอบได้มากกว่า 1  ข้อ เชน่ ช่วง
ระยะเวลาที�ใช้งานระบบสารสนเทศ  โดยถ้าใช้งานข้อไหน ให้ใสต่วัเลขเป็น 1 ถ้าไม่ตอบให้ใส ่0

•  คําถามที�คําตอบให้ใสล่ําดบัที�  เชน่ ระบบสารสนเทศที�ใช้งานบ่อยที�สดุ 3 อนัดบัแรก โดย
จะใสค่่า 1  หน้าระบบที�ใช้งานบ่อยที�สดุ และจะใสค่่า 2  และ 3  หน้าระบบสารสนเทศที�ใช้งานบ่อยใน
ลําดบัถดัมา ถ้าระบบไหนที�ไม่ได้เลือกให้ใสข้่อมลูเป็น 0

•  คําถามที�ให้แสดงระดบัมากน้อย เช่น ระดบัความพงึพอใจ แบ่งออกเป็น  5 ระดบั คอื 1 
แทนด้วยพึงพอใจน้อยที�สดุ  2 พงึพอใจน้อย  3 พึงพอใจปานกลาง  4 พงึพอใจมาก  5 พึงพอใจมากที�สดุ



2. คําถามปลายเปิด เช่น  ข้อเสนอแนะ โปรแกรม SPSS  จะสามารถพิมพ์ข้อความได้ยาวไม่
เกิน 255 อกัขระ และถ้าพิมพ์เป็นข้อความจะไม่สามารถนํามาประมวลผลได้  จึงจําเป็นต้องสรุปข้อคําตอบ
นั �น เป็นรหสัตวัเลขแทนข้อความ

 3. คําถามที�ไม่ได้รับคําตอบ (Missing data) จะแทนค่าด้วย  9,  99, 999 … ขึ �นอยูก่บั
ขนาดของตวัแปรว่าใช้กี�หลกั



ความรู้เบื �องต้นเกี�ยวกับ SPSS

SPSS เป็นเครื�องมือสําหรับจัดกระทําข้อมูล สามารถนําข้อมูลจาก
แฟ้มข้อมูลมาประมวลผลด้วยตาราง สร้างกราฟ และวิเคราะห์ทางสถิติที�
หลากหลาย ถ้าผู้วิเคราะห์ต้องการใช้โปรแกรม SPSS ดําเนินการจดัการกบัข้อมลู 
วิเคราะห์ข้อมูล และรายงานผลการวิเคราะห์ข้อมูล ผู้ วิเคราะห์จะต้องเขียน
โปรแกรมคําสั�งเพื�อสั�งให้โปรแกรม SPSS กระทําตามที�ผู้วิเคราะห์ต้องการ



สอนการใชง้าน
ป้อนขอ้มูลใหม่

เปิดแฟ้มขอ้มูลชนิด Database 

Query(*.spq)
สร้าง query ใหม่โดยใช ้database 
Wizard
เปิดแฟ้มขอ้มูลชนิด SPSS (*.sav)

เปิดแฟ้มขอ้มูลอื�น ๆ (*)

ไม่ตอ้งการปรากฎหนา้จอเริ�มตน้การ
ทาํงานนี� อีก

การนําเข้าข้อมูลสู่โปรแกรม SPSS



ส่วนประกอบของหน้าจอส่วนประกอบของหน้าจอ
Title Bar

Menu Bar
Variables = กําหนด

ชื�อตัวแปร

Cell Editors = กําหนดค่าตัวแปร

Cases = ชุดของตัวแปร

View Bar = Data View, Variable View



spssการใช้รูปแบบอักษรและขนาดในโปรแกรม spss

จะกําหนดรูปแบบตวัอกัษรและขนาดในโดยโปรแกรมได้ตามต้องการ โดยนําเม้าท์ไปคลิกที�เมนู
หลกั View เมนรูอง Font ดงัภาพ



การตั �งชื�อตัวแปรและกาํหนดลักษณะของตัวแปรในหน้าต่าง Variable view 

การตั �งชื�อ อาจจะกําหนดเพื�อให้เข้าใจง่าย หรืออาจกําหนดเป็นตวัอกัษรย่อก็ได้

ตอนที� 1 ข้อมลูพื �นฐาน

ข้อ  1 เพศ = sex

ข้อ  2 อายุ = age

ข้อ  3 ระดบัการศกึษา = educ (education)

ข้อ  4 ประเภทบุคลากร = person1,  person2

ข้อ  5 คณะหรือสํานกัที�สงักดั = agencies

ตอนที� 2  การเข้าใช้งานระบบสารสนเทศ

ข้อ 1 ความถี�ในการเข้าใช้งาน = freq_use

ข้อ 2 เวลาในการเข้าใช้งาน = time1, time2, time3, time4, 

time5, time6, time7

ข้อ 3 ระบบสารสนเทศที�รู้จกัและใช้งาน = infor1, infor2, infor3, infor4



ตอนที� 3 ความพึงพอใจ

หวัข้อที� 1 ด้านการให้บริการ

ข้อที� 1.1 ให้บริการด้วยความสภุาพและเป็นมิตร =  satisfy1.1

ข้อที� 1.2 ดแูล เอาใจใส่ เตม็ใจให้บริการ =  satisfy1.2

ข้อที� 1.3 ให้คําแนะนํา หรือตอบข้อซกัถามตรงประเดน็  =  satisfy1.3

ข้อที� 1.4 มีเจ้าหน้าที�ประจําหน่วยงานตลอดช่วยการให้บริการ =  satisfy1.4

หวัข้อที� 2  ด้านกระบวนการขั �นตอนการให้บริการ 

ข้อที� 2.1 ให้บริการอย่างเป็นระบบ และเป็นขั �นตอน = satisfy2.1

ข้อที� 2.2 ความรวดเร็วในการให้บริการ = satisfy2.2

ข้อที� 2.3 ข้อมลูที�ให้มีความชดัเจน ถกูต้อง และเข้าใจง่าย = satisfy2.3



Variable viewVariable view
• Variable view เป็นหน้าต่างสําหรับการกําหนดชื�อ และชนิด ลกัษณะของตวั

แปรแตล่ะตวั

 Name = กาํหนดชื�อตัวแปร ความยาวไม่เกิน 7-10 ตัวอักษร (ขึ �นอยู่กับ version)
 Type = กาํหนดชนิดของตัวแปร Numeric ข้อมูลตัวเลข  String ข้อมูลตัวอักษร
 Width = กําหนดความกว้างของค่าตัวแปรหรือจาํนวนอักขระหรืออักษร
 Decimals = กาํหนดจาํนวนของจุดทศนิยม
 Label = คาํอธิบายตัวแปร เช่น sex คาํอธิบายคือ เพศ
 Values = การกาํหนดค่าให้กับตัวแปร เช่น ตัวแปร เพศ กําหนดให้ชาย เท่ากับ 1 หญิง เท่ากับ 2
 Missing = ค่าขอข้อมูลที�แสดงว่าผู้ตอบแบบสอบถามไม่ได้ตอบ เช่น ตัวแปร เพศ กําหนดค่า missing = 9
 Columns = กาํหนดความกว้างของช่อง Columns สําหรับกรอกข้อมูล 
 Align = กาํหนดลักษณะการวางข้อมูลว่าจะให้ตัวแปรให้ชิดซ้าย กลาง หรือ ขวา 
Measure = กําหนดมาตราวัดของตัวแปรว่าเป็นแบบใด ได้แก่ Scale, Ordinal หรือ Nominal



การลงข้อมูลตัวแปรใน Variable view

1. ลงชื�อตวัแปรที�ช่อง Name

2. Type โดยส่วนใหญ่มกักําหนด Numericc หรือ String 



การเลือกชนิดของตัวแปร มีให้เลือก 8 ชนิด

1. Numeric สําหรับตวัแปรที�เป็นตวัเลข

2. Comma สําหรับตวัแปรที�ข้อมลูเป็นจํานวนเงิน

3. Dot เป็นข้อมลูที�ใช้จดุคั�นหลกัพนั และใช้จลุภาคคั�นตําแหน่งทศนิยม เชน่ ตั �ง 8 ตําแหน่ง กบั
ทศนิยม 2 ตําแหน่ง ป้อนข้อมลู 1234 จะได้ค่า 1.234,00

4. Scientific Notation สําหรับให้แสดงค่าข้อมลูด้วยสญัลกัษณะทางคณิตศาสตร์

5. Date สําหรับป้อนข้อมลูในรูปของวนัที�

6. Dollar สําหรับข้อมลูในรูปของจํานวนเงินดอลล่าร์ โดยจะใสเ่ครื�องหมาย $ ให้หน้าตวัเลขที�
ป้อน

7. Custom currency สําหรับข้อมลูเชิงปริมาณ

8.  String สําหรับข้อมลูแบบตวัอกัษร ตวัเลข หรือเครื�องหมายต่าง ๆ ข้อมลูชนิดนี �ไม่สามารถ
นํามาใช้ในการคํานวณได้ แต่สามารถหาความถี�ได้



3. Width และ Decimals โดยส่วนใหญ่ไม่ต้องกําหนดก็ได้ ส่วน Label คือการกําหนดข้อความขยายชื�อ
     ตวัแปร เพื�ออธิบายชื�อตวัแปรและแสดงออกทางผลลพัธ์  ให้พิมพ์ตรงคอลมัน์ Label เช่น Sex โดยที� 

Label นี �จะแสดงผลในกราฟ

4. Value กําหนดคําอธิบายให้กบัค่าตวัแปร โดยให้คลิกที�ปุ่ มสีเทา จากนั �นจะพบกรอก Value Label ในช่อง 
Value  กําหนดเป็น 1 และ Value Label กําหนดเป็น Male แล้วกดปุ่ ม Add ส่วน  Female 

     กําหนดเป็น 2 



5. Missing ใช้ในกรณีที�คาดว่าอาจจะมีข้อมลูองกลุม่ตวัอย่างบางคนไม่สมบรูณ์ คือ ไม่ตอบมา หรือตอบมาไม่
    ชดัเจน

6. Measure สําหรับกําหนดมาตรการวดัของตวัแปรว่าจะเป็น Nominal หรือ Ordinal หรือ Scale 
(Interval และ Ratio) โดยปกติจะกําหนดเป็น Scale แม้ว่าตวัแปรจะอยู่ในมาตรการวดั Nominal 
Scale ก็ตาม ทั �งนี �เพราะว่าการป้อนข้อมลูนั �นจะป้อนเป็นตวัเลขรหสั 1 หรือ 2 หรือ 3 ดงันั �นจึงควรจะเลือกเป็น 
Scale สําหรับ Nominal นั �นเลือกก็ต่อเมื�อต้องการป้อนข้อมลูเป็นตวัอกัษร



Data View

เมื�อกําหนดชื�อตวัแปรและลกัษณะของตวัแปรแล้ว ให้นําเม้าท์มาคลิกที�เมน ูData View 
แต่ละคอลมัภ์ ก็จะปรากฏชื�อที�ตั �งไว้ และจะเริ�มป้อนข้อมลูลงไปในแต่ละแถว 



การบันทกึแฟ้มข้อมูลการบันทกึแฟ้มข้อมูล

• ไปยงั File->Save As

• กําหนดสถานที�จดัเก็บข้อมลูในช่อง Save in และกําหนดชื�อ File ในช่อง File name 
File ที�ได้จะมีนามสกลุเป็น .sav



การเปิดแฟ้มข้อมูล

หากต้องการเรียกแฟ้มข้อมลูที�มีอยู่แล้วออกมาแสดงเพื�อใช้ในการวิเคราะห์หรือป้อนข้อมลูเพิ�มให้

คลิกที�เมน ูFile เมนรูอง Open และเมนยู่อย Data 



Data View



Variable View



การวิเคราะห์ข้อมูล

    หลงัจากที�ตรวจสอบความถูกต้องของแบบสอบถามเรียบร้อยแล้ว จะนําข้อมลูในแบบสอบถามมา

เปลี�ยนแปลงเป็นรหสัตวัเลข (Code) แล้วบนัทกึรหสัลงในเครื�องคอมพิวเตอร์ ด้วยโปรแกรม SPSS

      ลักษณะของการวิเคราะห์ข้อมูล จะมีข้อสังเกตดังนี �

– แบบสอบถามเกี�ยวกบัสถานภาพทั�วไป ใช้วิธีการหาค่าความถี� (Frequency) โดยสรุปออกมาเป็น
ค่าร้อยละ (%)

– แบบสอบถามที�เป็นการสํารวจทศันคติเกี�ยวกบัความพึงพอใจ ใช้วิธีการหาค่าเฉลี�ย (X)และส่วน
เบี�ยงเบนมาตรฐาน (S.D.)

– แบบสอบถามที�เป็นข้อเสนอแนะ ใช้วิธีการหาความถี� (Frequency)



การประมวลผลและวเิคราะห์ข้อมูล (Analyze) 

การประมวลผลและวิเคราะห์ข้อมลู โดยใช้โปรแกรม SPSS  มีหลายคําสั�งขึ �นอยู่กบัสถิติที�
ต้องการวิเคราะห์ การวิเคราะห์เบื �องต้นที�ต้องใช้ในที�นี �คือ คําสั�ง Descriptive Statistics, 
Compare Means, Correlate และ Multiple Response ดงัแสดงรายละเอียดดงันี �



ความหมายของค่าสถิต ิ

 Mean คือ ค่าเฉลี�ย

 Median คือ ค่ามัธยฐาน

 Mode คือ ฐานนิยม

 Sum คือ ผลรวม

 Std.deviation คือ ความเบี�ยงเบนมาตรฐาน

 Variance คือ ค่าความแปรปรวน

 Range คือ ค่าพสัิย

 Minimum  คือ ค่าตํ�าสุด

 Maximum คือ ค่าสูงสุด

 S.E.mean คือ ค่าความคลาดเคลื�อนมาตรฐานของค่าเฉลี�ย

 Skewness คือ ค่าความเบ้

 Kurtosis คือ ค่าความโด่ง



1. การใช้คาํสั� ง Descriptive Statistics

คําสั�ง Descriptive เป็นคําสั�งในการอธิบายตวัแปรเชิงปริมาณ ตามสถิติที�ต้องการวิเคราะห์ 
เช่น Mean, Std. Deviation เช่น หาคา่เฉลี�ยของตวัแปรอายุ

เลือกเมน ูAnalyze -> Descriptive Statistics -> Descriptives จากนั �นจะ
แสดงหน้าต่าง Descriptive ซึ�งด้านซ้ายประกอบด้วยตวัแปรต่าง ๆ เลือกเฉพาะตวัแปร age กดปุ่ ม
ลกูศร ตวัแปรจะย้ายมาอยู่ในกล่อง Variable(s) กดปุ่ ม Options เลือกค่าสถิติที�ต้องการ เช่น 
Mean ,Std. deviaton , Minimum, Maximum แล้วกดปุ่ ม Continue กด OK

 โปรแกรมก็จะแสดงผลในหน้าจอ Output ดงัภาพ





หน้าต่าง Descriptives

Output



คําสั� ง Frequencies  เป็นคําสั�งในการอธิบายทั �งตวัแปรเชิงปริมาณ และตวัแปรเชิงกลุ่ม 
โดยการแจกแจงความถี�และคา่ร้อยละแบบทางเดียว

สําหรับตวัแปรเชิงคณุภาพในตอนที� 1 ในที�นี � คือ เพศ  ระดบัการศกึษา ประเภทบุคลากร  คณะ
หรือสํานกัที�สงักดั

เลือกเมน ูAnalyze -> Descriptive Statistics -> Frequencies   จากนั �นจะ
แสดงหน้าต่าง Frequencies ซึ�งด้านซ้ายประกอบด้วยตวัแปรต่าง ๆ เลือกตวัแปร sex, educ, 
person1, person2, และ agencies กดปุ่ มลูกศร ตัวแปรจะย้ายมาอยู่ในกล่อง 
Variable(s) แล้วกดปุ่ ม Continue กด OK

 โปรแกรมก็จะแสดงผลในหน้าจอ Output ดงัภาพ



การวเิคราะห์หาค่าความถี�



หน้าต่าง Frequencies การเลือกตัวแปรหาค่าความถี� และค่าสถติพิื �นฐาน



หน้าต่าง Output





หากต้องการสร้างกราฟให้ไปที� Frequencies แล้วคลิกปุ่ ม Charts จะปรากฏหน้าต่าง 

Frequencies : Charts เช่น เลือกตวัแปร person1 แล้วกดปุ่ ม Charts เลือกรูปแบบกราฟ



กราฟแท่งของตัวแปร person1



คําสั�ง Crosstabs เป็นคําสั�งในการอธิบายตวัแปรทั �งเชิงปริมาณ และตวัแปรเชิงกลุม่ โดยการ
สร้างตารางแจกแจงความถี�และค่าร้อยละ ตั �งแต่ 2 ทางขึ �นไป

เลือก เมน ูAnalyze -> Descriptive Statistics -> Crosstabs จากนั �นจะแสดง
หน้าต่าง Crosstabs ซึ�งด้านซ้ายประกอบด้วยตัวแปรต่าง ๆ ส่วนด้านขวามี 2 กล่อง ให้ใส่ตัวแปร 
ดงันี � 

1) Row(s) จะใสต่วัแปรเชิงปริมาณหรือตวัแปรเชิงกลุ่ม ที�ต้องการแจกแจงความถี�และค่าร้อย
ละตามแถว ในที�นี �คือ ตวัแปรเพศ  (sex) 

2) Column(s) จะใส่ตวัแปรเชิงกลุม่ที�ต้องการจําแนกความถี�และร้อยละตามคอมลมัภ์ในที�นี �
คือ ตวัแปรตอนที� 2 ความถี�ในการใช้งาน (Freq_use)

3) เลือก Cells ซึ�งจะแสดงหน้าต่าง Crosstabs : Cell Display ใช้ในการแสดงค่า
ร้อยละ จําแนกตามแถวหรือคอลมัภ์ โดยสว่นใหญ่จะจําแนกค่าร้อยละตามคอลมัภ์ 

4) 





หน้าต่าง Crosstabs



Output



2. การใช้คําสั�ง Multiple Response

Multiple Response : Define Sets เป็นคําสั�งที�ใช้ในการสร้าง Set ของตวัแปรที�มีหลาย
คําตอบ (ข้อคําถามที�ตอบได้มากกว่า 1 ข้อ) หลงัจากสร้าง Set ของตวัแปรแล้ว สามารถทําการวิเคราะห์ตวัแปร
ชนิดนี �โดยการหาค่าความถี� (Frequencies) ค่าร้อยละ (Percentage) และการสร้างตารางไขว้ 
(Crosstab)

เลือกเมน ูMultiple Response -> Define Variable sets จากนั �นจะแสดงหน้าต่าง 
Define Multiple Response Sets  วิธีการ คือ

1) เลือกตวัแปรที�เป็นข้อคําถามตอบได้มากกว่า 1 ข้อ คือ ช่วงเวลาที�ใช้งานระบบ คือ time1…time7 
คลิกลกูศรเพื�อย้ายมาไว้ด้านขวามือ 

2) ในกล่อง Variables are Coded As ให้เลือก Dichotomies Counted Value ระบุ
ค่าเป็น 1  

3) ช่อง Name ให้ใส่ EXE  ช่อง Label ให้ใส่ชื�อใหม่เป็น time 

4) คลกิปุ่ ม Add เพื�อเพิ�มตวัแปรที�ช่อง Multiple Response Sets คือ $EXE จากนั �นเลือก 
Close 
ดงัภาพ

 





หน้าต่าง Define Multiple Response Sets



Multiple Response : Frequencies เป็นคําสั�งที�ใช้ในการหาค่าความถี�และคา่ร้อย
ละของตวัแปรที�มีหลายคําตอบ หรือข้อคําถามที�มีได้หลายคําตอบ

เลือกเมน ูMultiple Response -> Frequencies จากนั �นจะแสดงหน้าต่าง 
Multiple Response Frequencies ซึ�งหน้าต่างด้านซ้าย คือ Multiple Response 
Sets จะแสดงตวัแปรที�ทําการ Define sets ในที�นี �คือ time ($EXE) คลิกแล้วนํามาวางที�
หน้าต่างด้านขวา Table(s) จากนั �นกดปุ่ ม OK









3. การใช้คาํสั� ง Compare Means

คําสั�ง Means เป็นคําสั�งที�ใช้ในการหาค่าเฉลี�ยของตวัแปรเชิงปริมาณ จําแนกตามตวัแปรเชิง
กลุ่ม เช่น ค่าเฉลี�ยของอายจุําแนกตามเพศ

เลือกเมน ูCompare Means -> Means จากนั �นจะแสดงหน้าต่าง Means ซึ�ง
ด้านซ้ายประกอบด้วยตวัแปรต่าง ๆ ส่วนด้านขวามี 2 กล่อง ได้แก่

1) Dependent List จะใสต่วัแปรเชิงปริมาณที�ต้องการหาค่าสถิติต่าง ๆ เช่น ผลรวม 
ค่าเฉลี�ย คา่ส่วนเบี�ยงเบนมาตรฐาน ในที�นี �คือ age

2) Independent List จะใส่ตวัแปรเชิงกลุ่มที�ต้องการจําแนก ในที�นี �คือ sex 

3) เลือก options เพื�อใส่คา่สถิติ เช่น Mean, STD, Number of Cases, 
Minimum , Maximum

4) เลือก Continue แล้วเลือก OK ดงัภาพ

 







Output



การจัดกระทาํกับข้อมูล

1. การแปลงค่าข้อมูล

บางครั �งอาจมีความจําเป็นบางประการที�จะต้องเปลี�ยนข้อมูลของบางตัวแปร ถ้าหากกลุ่ม

ตวัอย่างมีจํานวนมาก การจะเข้าไปเปลี�ยนข้อมลูย่อมเป็นเรื�องลําบากและเสียเวลา โปรแกรม SPSS มี
คําสั�งให้การช่วยเหลือ ดงันี �

1.1 คําสั�ง Recode

จากตวัอย่างข้อมลู ผู้วิจยัต้องการแจกแจงความถี�จําแนกตามความถี�ในการเข้าใช้งานระบบ
สารสนเทศ ให้เป็น 2 ความถี� คือ 1) สปัดาห์ละไม่เกิน 2 ครั �ง  2) มากกว่าสปัดาห์ละ 2 ครั �ง

การแปลงข้อมลูจะใช้เมนหูลกั  Transform เมนรูอง Recode และเมนยู่อย Into 
Different Variables… เมนยู่อยนี �ใช้เมื�อต้องการแปลงค่าข้อมลูแล้วเก็บไว้ในตวัแปรใหม่ ถ้า
ต้องการแปลงค่าข้อมลูแล้วเก็บไว้ในตวัแปรเดิมให้เลือกที�เมนยู่อย into Same Variables…



ถ้าคลิกเลือกเมนยู่อย Into Different Variables… คลิกเลือกตวัแปรที�จะเปลี�ยน
ข้อมลูในช่องทางขวาให้ย้ายมาอยู่ในช่องทางซ้าย เช่น เลือกตวัแปร freq_use คลิกลกูศร ตวัแปรจะ
ย้ายมาอยู่ในช่อง Numeris Variable Output Variable 

ตั �งชื�อตัวแปรใหม่ที�เกิดจากการเปลี�ยนข้อมูลในตัวแปร freq_use ตั �งชื�อใหม่ว่า 
G_freq ให้พิมพ์ใส่ในช่อง Name และให้คลิกปุ่ ม Change ตวัแปร G_freq จะย้ายมาอยู่ใน
ช่อง Numeric Variable -> Output คลิกปุ่ ม Old and New Values… เพื�อแปลง
ข้อมลู



ต้องการแปลงข้อมลูความถี�ของการใช้งานระบบสารสนเทศ โดยให้กลุ่มที�ใช้งานไม่
เกินสปัดาห์ละ 2 ครั �งให้เป็นกลุม่ที� 1 และใช้งานมากกว่าสปัดาห์ละ 2 ครั �งให้เป็นกลุม่ที� 2 ดงันั �นใน

กรอบ Old Value ให้คลิกที� Range ช่องแรกใส่เลข 1  ช่องที�สอง ใส่เลข 2 
ในกรอบ New value ให้คลิกที� Value ใสเ่ลข 1 ปุ่ ม Add จะกลายเป็นสีดํา ให้

คลิกที�ปุ่ ม Add  



กดปุ่ ม Continue โปรแกรมจะทําการแปลงข้อมลูให้ใหม่ และจะมีตวัแปรเพิ�มเข้ามาในส่วนของ
หน้าจอ Data View อีก 1 ตวัแปร คือ G_freq



1.2 คาํสั�ง Compute

จากข้อมลูแบบสอบถามในส่วนของข้อมลูตอนที� 3 หากต้องการหาค่าเฉลี�ยรวมของหวัข้อที� 
1 ให้คลิกที�เมนูหลัก Transform เมนูรอง Compute จะปรากฏหน้าต่าง Compute 

Variable



ให้ตั �งชื�อตวัแปรใหม่ในช่อง Target Variable: เช่นตั �งชื�อวา่ Satisfy1 ซึ�งเป็นตวัแปรที�จะ
เก็บผลที�ได้จากการบวกค่าตวัเลขและนํามาหารด้วยจํานวนข้อย่อยทั �งหมด ตั �งแต่ satisfy1.1 –
satisfy1.4  

ภายในช่อง Numeris Expression ให้ใส่ชื�อตวัแปรที�ต้องการนํามาบวก โดยการนําเม้าท์
ไปคลิกเลือกเครื�องวงเล็บเปิดเลือกชื�อตวัแปรแล้วกดปุ่ มลกูศร แล้วคลิกเครื�องหมาย + คั�นทกุตวัแปร ใส่
เครื�องหมายวงเล็บปิด แล้วใสเ่ครื�องหมายสแลท (/) และใส่เลขจํานวนข้อย่อย คือ 4 ปิดท้าย แล้วคลิกปุ่ ม 

OK



ภายในตารางข้อมลูจะเกิดตวัแปรใหม่ขึ �นมาคือ Satisfy1



2. การเลือกข้อมูล

คาํสั�ง select cases 

จากข้อมูลตัวอย่างหากต้องการเลือกเฉพาะกลุ่มตัวอย่างที� เป็นเพศชายมา

      คํานวณค่าสถิติ  สามารถทําได้โดยใช้เมนหูลกั DATA และเมนรูอง Select Cases จะปรากฏ    
      หน้าต่าง Select Cases ให้คลิกเลือก If condition is satisfied และคลิกปุ่ ม if 



จะปรากฏหน้าต่าง Select Cases if ต้องการเลือกเฉพาะกลุ่มตวัอย่างที�เป็นเพศชายมาใช้
ในการคํานวณ ให้คลิกตวัแปร sex  แล้วกดปุ่ มลกูศร ชื�อตวัแปรจะย้ายมาอยู่ด้านขวา คลิกเครื�องหมาย 
= และพิมพ์ 1 แล้วคลิกปุ่ ม Continue



โปรแกรมจะแสดงผลการเลือกเฉพาะกลุ่มเพศชาย โดยจะเพิ�มตวัแปรใหม่ชื�อ Filter_$ โดยจะ
มีรหัสข้อมูลเป็น 1 และ 0  รหัส 1 คือ เลือกกลุ่มตัวอย่างนั �นมาคํานวณ และรหัส 0 คือ ไม่เลือกกลุ่ม
ตวัอย่างนั �นมาคํานวณ หรือสงัเกตตรงตวัเลขที�แสดงลําดบัของกลุ่มตวัอย่าง จะมีเครื�องหมายขีดอยู่ นั�น
คือกลุม่ตวัอย่างลําดบันั �นไม่ถกูเลือกเข้ามาคํานวณ

ในการกําหนดเงื�อนไขสามารถกําหนดได้หลาย ๆ เงื�อนไข เช่น เลือกกลุ่มตวัอย่างที�เป็นเพศชาย และ

ประเภทบุคลากรสายวิชาการ เงื�อนไข คือ   sex = 1 & personal = 2



3. การเพิ�มลดข้อมูล

การลบตัวแปรและกลุ่มตัวอย่าง

หากมีตวัแปรที�ไม่ต้องการ หรือข้อมลูแถวใดที�อยากจะลบทิ �งไป ให้คลิกเลือกชื�อตวัแปรหรือแถว 
จะมีแถบดํา คลิกขวาที�เม้าท์แล้วเลือก cut ตวัแปรหรือข้อมลูบางแถวก็จะถกูลบทิ �ง

การแทรกตัวแปรและกลุ่มตัวอย่าง

การแทรกตวัแปร ให้คลิกไปที�ตําแหน่งของตวัแปรหรือแถวที�ต้องการแทรกจะเกิดแถบดํา ให้คลิก
ขวาที�เม้าท์แล้วเลือก Insert Variable หรือ Insert cases จะเกิดคอลมัภ์หรือแถววา่งขึ �น ณ 
ตําแหน่งที�เลือก 

การรวมแฟ้มข้อมูล : กรณีรวมตัวแปร

ในการแทรกกลุ่มตวัอย่างหรือแทรกตวัแปร เช่น ต้องการรวมข้อมลูที�เคยป้อนในตอนที� 1 และ 2 
ในชื�อแฟ้ม Data1.sav ส่วนในตอนที� 3 ตั �งชื�อแฟ้มว่า Data2.sav แล้วต้องการเอาข้อมลูมา
รวมกนั ทําได้ดงันี �



1. เปิดแฟ้มข้อมลู Data1.sav ขึ �นมาก่อน

2. จากนั �นคลิกที�เมนหูลกั Data เมนรูอง Mearge file และเมนยู่อย Add 
Variables… 



จะปรากฏหน้าต่าง Add Variables ให้เลือกข้อความ An extenal SPSS data file 

แล้วกดปุ่ ม Browse เลือกแฟ้มข้อมลูที�ต้องการนํามารวม แล้วคลิก open



เมื�อปรากฏหน้าต่าง Add Variables from แล้วกดปุ่ ม OK

โปรแกรมจะจัดการแทรกตวัแปรจาก
แ ฟ้ ม ข้ อ มู ล ที�  2  ต่ อ ท้ า ย จ า ก
แฟ้มข้อมูลที� 1 แล้วให้ทําการบันทึก
แฟ้มเป็นชื�อใหม่

ในการแทรกกลุ่มตวัอย่างก็ใช้วิธีการแบบเดียวกนัเพียงแต่เมนหูลกั Data เมนรูอง Merge files 
เมนยู่อย Add cases



การทดสอบสมมตฐิานทางสถติิ

การทดสอบสมมติมีจุดมุ่ งหมายที� จะอ ธิบายหรือสรุปลักษณะของประชากร 
(ค่าพารามิเตอร์) ด้วยข้อมลูที�เก็บรวบรวมได้จากกลุม่ตวัอย่าง โดยใช้สถิติเชิงสรุปอ้างอิง

ขั �นตอนการทดสอบสมมติฐานทางสถติิ

1. การตั �งสมมติฐานทางสถิติเพื�อทดสอบเป็นการตั �งสมมติฐานเกี�ยวกบัค่าพารามิเตอร์
ของประชากร โดยต้องมีทั �งสมมติฐานหลกั หรือสมมติฐานทางการวิจยั (��) และสมมติฐานรอง 
หรือสมมติฐานทางสถิติ หรือสมมติฐานที�นกัวิจยัตั �งไว้ (��) 



การกาํหนดสถติิทดสอบ

1. การทดสอบสมมติฐานเกี�ยวกบั ค่าเฉลี�ยของประชากร (�) โดยใช้ค่าเฉลี�ยของ
ตวัอย่าง ×�  (การใช้คําสั�ง Compare Means : Means)  แต่ในกรณีต่อไปนี �

     1.1 ทดสอบค่าเฉลี�ยของประชากรเดียว โดยใช้สถิติทดสอบ t-Test จะเลือกใช้ 

One-Sample T Test

1.2 ทดสอบความแตกต่างระหว่างคา่เฉลี�ยของ 2 กลุ่มประชากร โดยใช้สถิติ
ทดสอบ t-Test  จะเลือกใช้ Independent-Sample T Test

1.3 ทดสอบความแตกต่างระหว่างคา่เฉลี�ยของ 2 กลุ่มประชากรแบบจบัคู่ โดยใช้
สถิติแบบ t-Test จะเลือกใช้ Paired-Sample T Test

1.4 การเปรียบเทียบความแตกต่างของค่าเฉลี�ยมากกว่า 2 กลุ่มประชากร หรือการ
วิเคราะห์ความแปรปรวนทางเดียว โดยใช้สถิติทดสอบ F-Test จะเลือกใช้ One-way 

Anova



1.5 การเปรียบเทียบค่าเฉลี�ยของประชากรเป็นรายคู่ หรือการเปรียบเทียบเชิงซ้อน ในกรณี
ที�ทราบว่ามีความแตกต่างของค่าเฉลี�ยมากกว่า 2 กลุม่ประชากร โดยส่วนใหญ่จะใช้ LSD (Least-
Significant Different) โดยเลือกใช้ One-way Anova :  Post Hoc Multiple 
Comparisons 

2. การวิเคราะห์ความสมัพนัธ์ระหว่างตวัแปรเชิงกลุ่ม 2 ตวั ในการทดสอบความเป็นอสิระกนั
ของ 2 ตวัแปร โดยเลือกใช้สถิติทดสอบ Chi-Square ใน spss จะเลือกใช้คําสั�ง Crosstabs และ
เลือกสถิติทดสอบแบบ Chi-Square เช่น การหาความสมัพนัธ์ระหว่างประเภทบคุลากร กบั ความถี�ใน
การใช้งานระบบ

3. การวิเคราะห์ความสมัพนัธ์ระหว่างตวัแปรเชิงปริมาณ 2 ตวั หรือการทดสอบ สมัประสิทธิ�
สหสมัพนัธ์ (Correlation Coefficient) ว่าด้วยตวัแปร 2 ตวั มีความสมัพนัธ์มากน้อยเพียงใด ใน 
spss จะเลือกใช้ Correlate และมี 2 คําสั�งให้เลือก คือ

     3.1 Bivariate เป็นการหาค่าสมัประสิทธิ�สหสมัพันธ์ของตวัแปรเชิงปริมาณ 2 ตวั ที�
แสดงความสมัพนัธ์ในรูปเชิงเส้น โดยไม่คํานึงถึงตวัแปรอื�น ๆ ที�เกี�ยวข้องเลย จึงทําให้ความสมัพนัธ์ที�ได้ไม่ใช่
ความสมัพนัธ์ที�แท้จริง ระหว่างตวัแปร 2 ตวั อาจจะมีตวัแปรอื�น ๆ แอบแฝงอยู่

3.2 Partial เป็นการหาความสมัพนัธ์ของตวัแปรเชิงปริมาณ 2 ตวั ที�ได้ควบคมุหรือกําจดั
อิทธิพลของตวัแปรอื�น ๆ โดยจะเหลือเพียงตวัแปร 2 ตวัที�ต้องการหาความสมัพนัธ์ เท่านั �น



สรุปข้อมูลประเภทต่าง ๆ ที�สามารถวเิคราะห์ทางสถิติได้ 

การวิเคราะห์ ประเภท ตัวอย่างวิธีการทางสถติิ

การเปรียบเทียบ เชิงปริมาณ การทดสอบเกี�ยวกบัค่าเฉลี�ย

เชิงปริมาณ + เชิงคณุภาพ (t-Test,  pair-test, F-Test)

ความสมัพนัธ์ เชิงปริมาณ + เชิงคณุภาพ สหสมัพนัธ์ (correlation)

เชิงคณุภาพ + เชิงคณุภาพ ตาราง crosstab (chi-square)

เหตผุล เชิงปริมาณ + เชิงปริมาณ การวิเคราะห์ความถดถอย 
(Regression Analysis)

เชิงคณุภาพ + เชิงคณุภาพ ตาราง crosstab



สถติใินการทดสอบสมมตฐิาน

1. ทดสอบค่าเฉลี�ยของประชากรเดียว  ใช้สถิติทดสอบ t-Test ใน spss จะ
เลือกใช้การวิเคราะห์ข้อมลูแบบ One-Sample T Test เช่น การทดสอบรายได้เฉลี�ยของกลุ่ม
ตวัอย่าง เท่ากบั 25,000 บาทต่อเดือนหรือไม่

 �� : � = 25,000  �� � ≠ 25,000

- เลือกเมน ูAnalyze -> Compare Mean -> One-Sample T Test 
จากนั �นจะแสดงหน้าต่าง One-Sample T – Test 

- คลิกตวัแปร salary แล้วคลิกลกูศรย้ายตวั ไปช่อง Test Variable(s) 

- ให้ใส่คา่คงที�ในการทดสอบ คือ 25,000  แล้วกดปุ่ ม OK จะปรากฎดงัภาพ

- กดปุ่ ม Option เพื�อระบคุ่า Confidence Interval (ระดบันยัสําคญั) 95%
จากนั �นกดปุ่ ม Continue และกดปุ่ ม Ok

 





ผลลพัธ์ในการทดสอบค่าเฉลี�ยของประชากรเดียว

รายได้เฉลี�ยของกลุม่ตวัอย่าง คือ 34,530 บาท ส่วนเบี�ยงเบนมาตรฐาน คือ 
12,127.65 

ผลการทดสอบสมมติ พบว่า ค่าสถิติทดสอบ t-Test = 7.858  ค่า Sig. = 
0.000* ซึ�งมีคา่น้อยกว่าระดบันยัสําคญัที�ตั �งไว้ (0.05) 

สรุปได้ว่า ปฏิเสธสมมติฐานหลกั �� และยอมรับสมมติฐาน ��
แสดงว่ารายได้เฉลี�ยของกลุ่มตวัอย่างไม่เท่ากบั 25,000 บาทต่อเดือนอย่างมี

นยัสําคญัที�ระดบั 0.05 (มากกว่า 25,000 บาทต่อเดือน) 



2. ทดสอบความแตกต่างระหว่างค่าเฉลี�ยของ 2 กลุ่มประชากร โดยใช้สถิติทดสอบ

t-Test ใน จะเลือกใช้ Independent-Samples T Test เช่น การทดสอบรายได้เฉลี�ยของกลุ่ม
ตวัอย่างเพศชาย และหญิง วา่มีความแตกตา่งกนัหรือไม่ (กลุม่  1 คือ เพศชาย กลุ่ม 2 คือ เพศหญิง)

ตั �งสมมติฐาน  �� : ��= ��  �� : �� ≠ ��
- เลือกเมน ูAnalyze -> Compare Mean -> Independent-Samples T 

Test จากนั �นจะแสดงหน้าต่าง Independent-Samples T Test 

- คลิกตวัแปรที�ต้องการทดสอบ คือ salary คลิกลูกศร ตวัแปรจะย้ายไปอยู่ในช่องด้านขวา 

Test Variable(s) 

- คลิกตวัแปรกลุ่มที�ต้องการจําแนก ในที�นี � คือ sex คลิกลกูศรด้านล่าง ตวัแปรจะย้ายไปอยู่ใน
ช่อง Grouping Variable สงัเกตเหน็วา่ตวัแปร sex จะมีเครื�องหมาย ? ?

- คลิกปุ่ ม Define Groups จําแนกเป็น Group1 ใส่เลข 1 (ชาย) Group2 ใส่เลข 2 
(หญิง) 

- กดปุ่ ม Option เพื�อระบุค่า Confidence Interval (ระดบันยัสําคญั) 95%จากนั �น
กดปุ่ ม Continue และกดปุ่ ม Ok







ผลลพัธ์ในการทดสอบความแตกต่างระหวา่งค่าเฉลี�ยของ 2 กลุ่มประชากร

รายได้เฉลี�ยของกลุม่ตวัอย่างเพศชาย 32,526 บาท ส่วนเบี�ยงเบนมาตรฐาน 
12,654.91 บาท และรายได้เฉลี�ยของกลุม่ตวัอย่างเพศหญิง 37,186 บาท ส่วนเบี�ยงเบน
มาตรฐาน 10,976.72 บาท 

ผลการทดสอบสมมติฐาน พบว่า 

1) ค่าสถิติทดสอบความแปรปรวนของกลุ่มตวัอย่าง (Levene’s Test for 
Equality of Variance) F-Test = .087 ค่า sig = .768 ซึ�งมากกว่าระดบันยัสําคญั
ที�ตั �งไว้ (0.05) สรุปได้ว่า ยอมรับสมมติฐานหลกั  (��) คือ ความแปรปรวนของกลุ่ม
ตวัอย่างไม่มีความแตกต่างกนั ให้ใช้ Equal variances assumed 

2) ค่าสถิติทดสอบความแตกต่างระหว่างค่าเฉลี�ยของ 2 กลุ่มประชากร (t-Test for 
Equality of Means) t-Test = -1.928 , df = 98 , Sig =  .057 ซึ�งมากกว่า
ระดบันยัสําคญัที�ตั �งไว้ (0.05) สรุปได้ว่า ยอมรับสมมติฐานหลกั (��) นั�นคือ รายได้เฉลี�ยของ
กลุม่ตวัอย่างเพศชายและเพศหญิงไม่แตกต่างกนัอย่างมีนยัสําคญัทางสถิติที�ระดบั 0.05 



3. ทดสอบความแตกต่างระหว่างค่าเฉลี�ยของ 2 กลุ่มประชากรแบบจับคู่  โดย
ใช้สถิติทดสอบ t-Test  ใน spss จะเลือกใช้ Paired-Samples T Test เช่น การทดสอบ
คะแนนเฉลี�ยก่อนอบรมและหลงัการอบรม ตวัอย่างการทดสอบความรู้เกี�ยวกบัโปรแกรม spss

ข้อที� คะแนนก่อนอบรม คะแนนหลังอบรม

1 9 12

2 8 13

3 7 15

4 8 17

5 5 18

6 6 16

7 7 14

8 4 18

9 5 13

10 4 19



- เลือกเมน ูAnalyze -> Compare Mean -> Paired-Samples

T Test จากนั �นจะแสดงหน้าต่าง Paired-Samples T Test 

- คลิกเลือกตวัแปร pre และ post  คลิกลกูศร ตวัแปรทั �งสองจะย้ายมาอยู่ในช่อง 
Paired Varliables โดยตวัแปร pre จะอยู่ในช่อง Variables1 ตวัแปร post จะอยู่ใน
ช่อง Variable2 

- คลิกปุ่ ม Options เพื�อระบคุ่า Confiedence Interval ในที�นี �เลือก 95%

จากนั �นกดปุ่ น Continue และกด Ok ดงัภาพ





ผลลพัธ์ในการทดสอบความแตกต่างระหวา่งค่าเฉลี�ยของ 2 กลุ่มประชากรแบบจบัคู่

คะแนนเฉลี�ยก่อนการอบรมเท่ากบั 6.3 คะแนน ส่วนเบี�ยงเบนมาตรฐาน 1.77 
คะแนน และคะแนนเฉลี�ยหลงัการอบรมเท่ากบั 15.5 คะแนน ส่วนเบี�ยงเบนมาตรฐาน 2.46 
คะแนน ค่าสมัประสิทธิ�สหสมัพนัธ์ (correlation หรือ (r) ) = -.677 , sig = .031 ซึ�ง
มากกว่าระดบันยัสําคญัที�ตั �งไว้ (0.05) 

สรุปได้ว่า ปฏิเสธสมมติฐานหลกั (��) ยอมรับสมมติฐานรอง (��) คือ ค่าเฉลี�ย
ก่อนการอบรมและหลงัการอบรมมีความสมัพนัธ์กนั

ค่าสถิติทดสอบความแตกต่างระหว่างคา่เฉลี�ยของ 2 กลุ่มประชากรแบบจบัคู ่Paired  
Differences Sample t-Test = -7.495 , df = 9 , Sig = .000 ซึ�งน้อยกว่าระดบั
นบัสําคญัที�ตั �งไว้ (0.05) 

สรุปได้ว่า  ปฏิเสธสมมติฐานหลกั (��) ยอมรับสมมติฐานรอง (��)  คือ ค่าเฉลี�ย
ก่อนการอบรมและหลงัการอบรมมีความแตกต่างกนั



4. การเปรีบเทียบความแตกต่างของค่าเฉลี�ยมากกว่า 2 กลุ่มประชากร หรือการ
วิเคราะห์ความแปรปรวนแบบทางเดียว โดยใช้สถิติทดสอบ F-Test ใน spss จะเลือกใช้ 
One-way ANOVA เช่น การทดสอบอายเุฉลี�ยของกลุม่ตวัอย่าง จําแนกตามระดบัการศกึษา 
(กลุม่ 1 ตํ�ากวา่ ป.ตรี  2 ป.ตรี   3  ป.โท  4 ป.เอก) ว่ามีความแตกตา่งกนัหรือไม่

ตั �งสมมติฐาน

 �� : ��= �� = �� = �� ,  �� :  �� ≠ �� ≠ �� ≠ ��

และการเปรียบเทียบค่าเฉลี�ยของประชากรเป็นรายคู ่หรือการเปรียบเทียบเชิงซ้อน ในกรณีที�ทราบ
ว่ามีความแตกต่างของค่าเฉลี�ยมากกว่า 2 กลุม่ประชากร โดยส่วนใหญ่จะใช้ LSD (Least-
Significant Different) โดยเลือกใช้ One-Way ANOVA : Post Hoc 

Multiple Comparisons 

 �� :  ��= �� = �� = �� : �� = �� อย่างน้อย 1 คู ่ I ≠ j 



- เลือกเมน ูAnalyze -> Compare Mean -> One-Way ANOVA 
จากนั �นจะแสดงหน้าต่าง One-Way ANOVA 

- คลิกเลือกตวัแปรเชิงปริมาณที�ต้องการทดสอบความแตกต่างของค่าเฉลี�ย ในที�นี �คือ 
age แล้วคลิกลกูศร ตวัแปรจะย้ายไปอยู่ในช่อง Dependent List คลิกเลือกตวัแปรเชิงกลุ่ม
ที�ต้องการจําแนกตามกลุม่ ในที�นี �คือ ระดบัการศกึษา

- จากนั �นเลือก Post Hoc ซึ�งจะแสดงหน้าต่าง One-Way ANOVA : Post 
Hoc Multiple Comparisons เลือก Equal Variances Assumed: LSD และ
เลือก Significance level = 0.05 จากนั �นเลือก Continue 

- เลือก Options เพื�อระบคุ่า Confidence Interval ในที�นี �เลือก 95% 
จากนั �นคลิกปุ่ ม Continue และปุ่ ม OK ดงัภาพ







ผลลพัธ์ในการทดสอบความแตกต่างของค่าเฉลี�ยมากกว่า 2 กลุม่ประชากร และความ
แตกต่างของค่าเฉลี�ยเป็นรายคู่

จากตาราง ANOVA จะได้ค่าของ Sum of Squares และ Mean Square 
ใน Between Groups, Within Groups ค่าสถิติทดสอบ F-Test = 7.561 , 

Sig = .001 ซึ�งน้อยกว่าระดบันยัสําคญัที�ตั �งไว้ (0.05) 

สรุปได้ว่า ปฏิเสธสมมติฐานหลกั (��) ยอมรับสมมติฐานรอง  (��) นั�นคือ กลุ่ม
ตวัอย่างที�มีอายเุฉลี�ยแตกต่างกนั จะมีระดบัการศกึษาแตกต่างกนัด้วย

ในกรณีที�ผลการทดสอบ พบว่า อายเุฉลี�ยมีความแตกตา่งกนั ถ้าระดบัการศกึษาของ
กลุม่ตวัอย่างมีความแตกต่างกนั จําเป็นจะต้องทําการทดสอบสมมติฐานต่อเพื�อให้ทราบว่าระดบั
การศกึษาคู่ใดมีความแตกต่างกนั โดยใช้ค่า LSD พบว่า กลุ่มตวัอย่างที�มีระดบัการศกึษาทกุลุ่มมี
อายแุตกต่างกนัทกุกลุ่ม โดยมีคา่ Sig น้อยกว่าระดบันยัสําคญัที� 0.05



5. การวิเคราะห์ความสมัพนัธ์ระหว่างตวัแปรเชิงกลุ่ม 2 ตวั ในการทดสอบความเป็น
อิสระกันของ 2 ตวัแปร โดยเลือกใช้สถิติทดสอบ Chi-Square ใน spss จะเลือกใช้คําสั�ง 
Crosstabs และเลือกสถิติทดสอบแบบ Chi-Square เช่น การหาความสมัพนัธ์ระหว่าง
ประเภทบคุลกรกบัความถี�ในการใช้งานระบบ

- เลือกเมน ูAnalyze -> Descriptive Statistics -> Crosstabs จากนั �น
จะแสดงหน้าต่าง Crosstabs 

- คลิกเลือกตัวแปรที�ต้องการจําแนกตามแถว ในที�นี � คือ ประเภทบุคบากร 
(person1) แล้วคลิกลกูศรด้านบน ตวัแปรจะย้ายไปอยู่ในช่อง Rows และคลิกเลือกตวัแปรที�
ต้องการจําแนกตามคอลมัภ์ ในที�นี �คือ ความถี�ในการใช้งาน (freq_use) คลิกลกูศรด้านล่าง ตวั
แปรจะย้ายไปอยู่ในช่อง Columns  

- จากนั �นเลือกปุ่ ม Statistics ซึ�งจะแสดงหน้าต่าง Crosstabs: Statistics
เลือก Chi-Square (สถิติทดสอบ) จากนั �นกดปุ่ ม Continue และกดปุ่ ม OK







ผลลพัธ์ในการทดสอบความสมัพนัธ์ของตวัแปรเชิงกลุ่ม 2 ตวั

จากตาราง Crosstabs เพื�อแสดงค่าความถี�และค่าร้อยละระหว่างประเภทบคุลากร 
(ตามแถว)  กบัความถี�ในการใช้งาน (ตามคอลมัภ์) เมื�อทดสอบความสมัพนัธ์ระหว่างระหวา่ง
ประเภทบคุลากรกบัความถี�ในการใช้งาน พบว่า Person Chi-Square = 93.792 และ 
Sig = .000 ซึ�งน้อยกว่าระดบันยัสําคญัที�ตั �งไว้ (0.05) 

สรุปได้ว่า ปฏิเสธสมมติฐานหลกั  (��) ยอมรับสมมติฐานรอง  (��) นั�นคือ ประเภท
บคุลากรและความถี�ในการใช้งานระบบสารสนเทศมีความสมัพนัธ์กนั 



6. การวิเคราะห์ความสมัพนัธ์ระหว่างตวัแปรเชิงปริมาณ 2 ตวั หรือการทดสอบ
สมัประสิทธิ�สหสมัพนัธ์ (Correlation Coefficient) ว่าตวัแปร 2 ตวั มีความสมัพนัธ์มาก
น้อยเพียงใด ใน spss การคํานวณหาค่าสมัประสิทธิ�สหสมัพนัธ์จะเลือกใช้คําสั�ง correlate 
และมี 2 คําสั�งให้เลือก คือ Bivariate กบั Partial 

การประมาณค่าสัมประสิทธิสหสมัพันธ์ของประชากร (�) โดยใช้ค่าสัมประสิทธิ�

สหสมัพนัธ์ของตวัอย่าง (r) ค่าสมัประสิทธิ�สหสมัพนัธ์มีค่าสงูสดุเป็น 1 และคา่ตํ�าสดุเป็น -1 โดยที�

1) ถ้าค่า r มีค่าเข้าใกล้ 1 หมายถึงตวัแปรเชิงปริมาณ 2 ตวั มีความสมัพนัธ์ในทิศทาง
เดียวกนั และมีความสมัพนัธ์กนัมาก

2) ถ้าค่า r มีค่าเข้าใกล้ -1 หมายถึงตวัแปรเชิงปริมาณ 2 ตวั มีความสมัพนัธ์ใน
ทิศทางตรงกนัข้ามและสมัพนัธ์กนัมาก

3) ถ้าค่า r มีค่าเข้าใกล้ 0 หรือเท่ากับ 0 แสดงว่ามีความสมัพนัธ์กันน้อยหรือไม่มี
ความสมัพนัธ์กนัเลย



ถ้าเลือก Bivariate

- เลือกเมน ูAnalyze -> Correlate -> Bivariate จากนั �นจะแสดงหน้าต่าง 
Bivariate Correlations 

- คลิกเลือกตวัแปรเชิงปริมาณที�ต้องการหาความสมัพนัธ์ ในที�นี �เลือกอาย ุ(age) และ
เงินเดือน (salary) 

- กล่อง Correlation Coefficients ให้เลือก Pearson Correlation 
และเลือก OK





ผลลพัธ์ในการทดสอบความสมัพนัธ์ของตวัแปรเชิงปริมาณ 2 ตวั แบบ Bivariate

Correlations
จากตาราง Correlations จะได้ค่า Person Correlation ระหว่างอายแุละ

เงินเดือน คือ .191 และค่า Sig = .058 ซึ�งมีคา่มากกว่าระดบันยัสําคญัที�ตั �งไว้ (0.05) 

สรุปได้ว่า ยอมรับสมมติฐานหลกั (��) นั�นคือ ตวัแปรอายแุละตวัแปรเงินเดือนไม่มี
ความสมัพนัธ์กนั

ถ้าเลือก Partial

- เลือกเมน ูAnalyze -> Correlate -> Partial จากนั �นจะแสดงหน้าต่าง 
Parial Correlations 

- คลิกเลือกตวัแปรเชิงปริมาณที�ต้องการหาความสมัพนัธ์ ในที�นี �เลือกอาย ุ(age) และ
เงินเดือน (salary) 

- กล่อง Correlation Coefficients ให้เลือก Pearson Correlation 
และเลือก OK





ผลลพัธ์ในการทดสอบความสมัพนัธ์ของตวัแปรเชิงปริมาณ 2 ตวั

จากตาราง Correlations จะได้ค่า Partial Correlation ระหว่างตวัแปรอายุ
กบัเงินเดือน โดยควบคมุอิทธิพลของตวัแปร เพศ ระดบัการศกึษา และประเภทบคุลากร คือ -.157 
และค่า Sig = .124 ซึ�งมากกว่าระดบันยัสําคญัที�ตั �งไว้ (0.05) 

สรุปได้ว่า ยอมรับสมมติฐานหลกั (��) นั�นคือ ตวัแปร อาย ุและเงินเดือนไม่มี
ความสมัพนัธ์กนั






